<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started in Web Intelligence 4.1</td>
</tr>
<tr>
<td>Log into EDDIE</td>
</tr>
<tr>
<td>Setting your Web Intelligence Preferences</td>
</tr>
<tr>
<td>Disconnected from Web Intelligence</td>
</tr>
<tr>
<td>Opening Web Intelligence Rich Client from your Desktop</td>
</tr>
<tr>
<td>Login to Web Intelligence (Connecting to the Server)</td>
</tr>
<tr>
<td>Creating a New Document</td>
</tr>
<tr>
<td>Query Panel Overview</td>
</tr>
<tr>
<td>Query Panel Toolbar:</td>
</tr>
<tr>
<td>Universe Outline:</td>
</tr>
<tr>
<td>Result Object Panel</td>
</tr>
<tr>
<td>Query Filter Panel</td>
</tr>
<tr>
<td>Data Preview</td>
</tr>
<tr>
<td>Answering Prompts</td>
</tr>
<tr>
<td>Report Manager Window</td>
</tr>
<tr>
<td>File Tab</td>
</tr>
<tr>
<td>Properties Tab</td>
</tr>
<tr>
<td>Document Toolbar</td>
</tr>
<tr>
<td>Left Sidebar Panel</td>
</tr>
<tr>
<td>Status Bar</td>
</tr>
<tr>
<td>Saving a Document as Web Intelligence</td>
</tr>
<tr>
<td>Saving to Other File Formats (Excel, PDF, CSV, and Text)</td>
</tr>
<tr>
<td>Saving Documents to EDDIE</td>
</tr>
<tr>
<td>Refreshing a Document</td>
</tr>
<tr>
<td>Editing a Query</td>
</tr>
<tr>
<td>Adding Objects to an Existing Query</td>
</tr>
<tr>
<td>Displaying the Object in Report Table</td>
</tr>
<tr>
<td>Sorting</td>
</tr>
<tr>
<td>Sections</td>
</tr>
<tr>
<td>Breaks</td>
</tr>
<tr>
<td>Inserting Calculations</td>
</tr>
<tr>
<td>Creating Additional Report Tabs</td>
</tr>
<tr>
<td>Duplicating a Report</td>
</tr>
<tr>
<td>Rename a Report</td>
</tr>
<tr>
<td>Filtering a Report</td>
</tr>
<tr>
<td>Using Report Filters</td>
</tr>
<tr>
<td>Using Simple Filters on the Filter Bar</td>
</tr>
</tbody>
</table>
Getting Started in Web Intelligence 4.1

Prior to logging into the Web Intelligence Rich Client software, you will need to login to your Business Objects account in EDDIE, select your Web Intelligence preferences, install the new Web Intelligence Rich Client 4.1 software, and then launch the program from EDDIE to download a needed security file. Please see the Web Intelligence 4.1 Getting Started Guide.

Log into EDDIE

1. Open the EDDIE login page: [https://eddie.ds.uillinois.edu/](https://eddie.ds.uillinois.edu/)

2. Enter your University NetID User Name and Password.

3. Click Log On
Setting your Web Intelligence Preferences

1. Select **Preferences** (upper right corner)

2. Under Preferences – select Web Intelligence

3. Under Modify (creating, editing and analyzing documents), select **Desktop** (Rich Client, Windows only, installation required)
4. Click the **Save & Close** button. (Bottom right corner of window)

5. From EDDIE home page **My Applications** menu, double-click the Web Intelligence icon.

6. When prompted to Open or Save the file, Click **Open**
7. Web Intelligence Rich Client opens and the home page is displayed:

Disconnected from Web Intelligence

Web Intelligence Rich Client will stay running even after you close the program. To completely disconnect:

1. Close the Web Intelligence window by clicking the \(\times\) in the upper-right corner.

2. In the bottom-right corner of your computer task bar, click the "button to show hidden icons. (Just to the left of your system clock)

3. **Right-click** on the Web Intelligence icon

4. **Select Quit**
Opening Web Intelligence Rich Client from your Desktop

1. Click on the Windows Start menu
2. Select All Programs
3. Select SAP Business Intelligence
4. Select SAP Business Objects Web Intelligence

The Web Intelligence Home Page is displayed:
Login to Web Intelligence (Connecting to the Server)

1. Open the Web Intelligence menu in the upper left corner of the screen.
2. Select Login As
3. Enter your University NetID and Password
4. Verify that the Authentication field is set to LDAP
5. Click Log On

Note: When you open the program, you will not be connected to the server. You must login to Web Intelligence before opening and refreshing reports. Note the status in the bottom right corner shows “Disconnected”
You are now logged in to Web Intelligence and connected to the server.

Creating a New Document

1. Choose a data source by selecting the **Universe** link (or select the universe from your recently used universes in the list).

2. Select the desired Universe from the list and click **Select**

   **Note:**
   You can use the filter box to search for a particular universe.
The Create Query Panel is displayed:
Query Panel Overview

**Query Panel Toolbar:**

1. **Add Query** – Use drop-down menu to select data source for additional queries.
2. **Hide / Show Data Preview Panel**
3. **Combine Query** – Select from Union, Intersection, or Minus
4. **Query Properties** – Name query, set limits, change prompt order, turn off retrieve duplicate rows.
5. **View Script** – View the SQL script for query
6. **Run Query**

**Universe Outline:**
The Universe Outline displays all of the Classes and Objects in the Universe.

**Searching for Objects and Filters**

1. Enter and word(s) that are contained in the object you are looking for.

2. The Universe Outline will be filtered to only show Classes, Objects, and Predefined Filters that contain that text.

**Expand All / Collapse All**
In Business Objects, Objects and Filters are organized in folders called *classes*. You can expand any of these folders by clicking the + next to the folder. You can choose to use the Expand All feature to expand all folders and objects, and the Collapse All feature to collapse all folders and objects.
1. Click **Expand all** to expand all folders in universe outline.
2. Click **Collapse all** to collapse or close all folders in the universe outline.

**Result Object Panel**

Double-click or Drag and Drop objects from the Universe Outline into the Result Object Panel to add them to your query.

1. Click the **X** button to remove selected object.
2. Click the **X** button to remove all objects.
Query Filter Panel

Filters allow you to limit the amount of data (number of rows) returned by your query. There are two types of Query Filters: Predefined and User-defined. Predefined Query Filters are filters that were built into the Universe. User-defined Query Filters can be created using any of the objects in the Universe.

Using Predefined Query Filters

1. Locate the Predefined Query Filter.

2. Double-click the filter, or drag and drop it into the Query Filter panel.
Creating User-defined Query Filters

Query Filters are composed of three components:

a. The Object (What do you want to compare or filter?)

b. The Operator (How do you want to compare the data?)

c. The Operand (What would you like to compare the data to?)

To Create a Filter:

1. Drag and Drop the desired object into the Query Filters panel.

2. Click the Operator drop-down menu to select an Operator. The default operator is In list.

3. Click the Operand Menu button to determine how you wish to identify the operand. Options include: Enter value is the Constant box, select values from the List of Values, or creating a Prompt and entering the values in the Prompt window.
4. If using the **Constant** option, enter the value(s) for your filter in the text box. To enter multiple values, use the semi-colon (;) to separate values. Remember that values must be entered exactly as they appear in the database and are case-sensitive.

5. If using the **Values from List**, select the value(s) from the list, then click the > button. Click **OK**.

6. If using the **Prompt** option, you may click the **Prompt Properties** button to change the way your prompt functions. You may also modify the prompt text in the text box.
Grouping Filters
To group two or more filters together to link with the ‘or’ logical operator:

1. Create filters to group.

2. Drag and Drop one filter on top of the other.

Note:
The system no longer shows the Blue Rectangular indicating that the filters will be grouped.

3. Click the ‘And’ operator to change to ‘Or’
Data Preview

Provides a preview of the data that will be generated once the query is run. Gives you an idea if your query is set up correctly without having to wait for the full query to generate. If this area is empty, Click Refresh to generate the preview. (Optional)

Answering Prompts

If your query contains prompts, the prompt window will be displayed when you run your query.

There are two methods for entering values in the Prompt Window:

- **Type a Value box**: Manually enter a value in this box. Remember that values must be entered exactly as they appear in the database and are case-sensitive.

- **Select Value(s) from the List**: select values from the list of values that is populated from the database.

  - When you have answered all prompts, click OK to run the query.
Report Manager Window

Once your query has run, the report will be displayed in the Report Manager window. This window has many toolbars and tabs that contain the various features available in Web Intelligence.

File Tab

Create a New Document – Will prompt you for a data source for new document.

Open an Existing Document – Will allow you to browse your files to open a document.

Save Document – Allows you to save your document as a Web Intelligence Document, Excel, PDF, CSV, or Text file. Also allows you to save document to your personal folders in EDDIE.

Print – Print your document

Find Text in Document – Search for particular text within the document.

Send Document as an Email Attachment – Opens a new Outlook message and attaches the report. Choices to send as Web Intelligence, Excel, PDF, CSV or Text.
Properties Tab

View – Allows you to view and hide the various menu bars.

Document – Document Properties including Refresh on Open.

Application – Set Web Intelligence options (Change Default folders, default measurement unit, etc)

Document Toolbar

Cut: Cuts the selected report elements and stores the contents in your Clipboard.

Copy: Copies the selected report elements and stores the contents in your Clipboard.

Paste: Pastes the selection stored in your Clipboard.

Undo: Undo your last action(s)

Redo: Redo an action that you had used the Undo action on.

Delete: Deletes the selected report element(s).

Edit Query: Opens the Query panel so you can make changes to your query.

Refresh Data: Refreshes the report data. Allows you to change Prompt Values.
**Left Sidebar Panel**

The left sidebar can be used to display information related to your Web Intelligence documents: Document Summary, Report Map, Input Controls, Available Objects, and Document structure and filters. To switch between these different views, you can use the toolbar on the left, or the drop-down menu on the top of the menu.

**Document Summary** – Shows information about the document such as file size, author, date created, and refresh and modify dates.

**Report Map** – Map of the document allows you to see an outline of all the reports and elements within the document.

**Input Controls** – Create and view input controls.

**Available Objects** – Shows available objects and variables for the document. Can be arranged in Alphabetic order, or by Query using the drop-down option at the bottom of the panel.

**Document Structure and Filters** – View the structural elements of the document as well as any report filters that are applied to the reports.
Status Bar

The Status Bar is located at the bottom of the Web Intelligence Report Manager window.

- **Page Navigation:** Shows the current/total page of document. Use arrows to navigate to other pages. (First page, Previous page, Next page, and Last page)

- **Print Preview:** Buttons allow you to toggle between print preview and quick display mode.

- **Refresh:** Displays the time elapsed since last refresh. Click the Refresh button to refresh document.

- **Connection Status:** Shows the server connection status. Options are **Connected** or **Disconnected**. If disconnected, you will not be able to refresh document. Click the status to login to server.

Saving a Document as Web Intelligence

1. In the **File** Tab, click the **Save** drop-down menu.

2. Select **Save as**

3. Select location to save to

4. Name the document

5. Check the **Save for All Users** and **Remove Document Security** checkboxes. (Enables other users to open and refresh the document).

6. Click **Save**
Saving to Other File Formats (Excel, PDF, CSV, and Text)

1. In the File Tab, click the Save drop-down menu.

2. Select Save as

3. In the Files of Type drop-down menu, select desired file type. Options include:
   a. PDF
   b. Excel 2007 (.xlsx)
   c. Excel (.xls)
   d. CSV
   e. Text

4. Select a location to save to and modify the file name if needed.

5. Click Save
Saving Documents to EDDIE

The Save to Enterprise feature allows you to save a copy of your document to the BI Launch Pad (EDDIE).

1. From the File tab, select the save drop-down menu
2. Click Save to Enterprise
3. Select the folder or Category to save document to
4. Click Save
Refreshing a Document

To refresh your document, or to bring up the prompt window to change prompt values:

1. Click the Refresh Button. You can find this button either on the left sidebar toolbar, or on the toolbar on the bottom-right of the document.

   Note:
   If the Refresh buttons are inactive or grayed-out, you may be working in Offline mode. See Appendix B: Trouble-shoot Common Issues

Editing a Query

To view or make changes to the query:

1. Click the Edit Data Provider button located on the left sidebar toolbar or in the Data Access Tab,
2. If you have multiple queries, select the tab for the query you would like to view or edit.

Adding Objects to an Existing Query

If you need to add additional objects to an existing query:

1. Click the Edit Data Provider button
2. Locate the object(s) to add and add them to the Result Objects panel.
3. Run the Query

Note:
You will notice that the new object is not displayed in your report table.
Displaying the Object in Report Table

1. Open the Available Objects menu.
2. Drag the new object into the table.
3. Use the blue rectangles to determine the location of the new column:
   - Insert column to the left of current column
   - Insert column to the right of current column
   - Replace column with new column

Sorting

By default, tables are sorted by the left-most column in ascending order. There are two methods for adding sorts to a table:

Right-click Menu

1. Right-click in the column to apply sort
2. Select Sort
3. Select the desired sort order (Ascending or)
Toolbar Option
1. Select the column to sort on
2. Select Analysis > Display
3. Click the Sort drop-down menu
4. Select the desired sort order (Ascending or Descending)

Changing Sort Priority
If a table has multiple sorts applied, you can use the Advanced sort menu to change the priority of the sorts:

1. From the Sort menu box, select Advanced
2. Select the object to change sort priority

3. Under Priority, click the ▲ or ▼ button

Create a Custom Order Sort

1. From the Sort menu box, select Advanced

2. Under Custom Order, select Values button.

4. Use the click the ▲ or ▼ button to rearrange the order of the sorting.

3. When finished, click OK
Sections
There are two methods to create a section within a report table:

Right-click Menu
1. Right-click in the desired column and select **Set as Section**

 Toolbar Option
1. Click in the desired column
2. Select the **Report Element > Tools > Set as Section**
Breaks

There are two methods to create a section within a report table:

Right-click Menu

1. Right-click in the desired column
2. Select **Break > Add Break**

![Right-click Menu Example]

Toolbar Option

1. Select the column for desired break
2. Select **Report Elements > Table Layout > Break > Add Break**

![Toolbar Option Example]
Managing Breaks

To manage the way a break is displayed or the properties for a break:

1. Select the column that contains the break.
2. Right-click and select **Breaks > Manage Break**

3. From this menu, you can:
   
   a. Add additional breaks and manage the priority of breaks
   
   b. Remove breaks
   
   c. Turn on/off break headers and footers
   
   d. Turn on/off sorting on breaks
   
   e. Change the way duplicate values are displayed within a break
   
   f. Avoid page breaks within a break
   
   g. Have header row repeated at the top of each page
Inserting Calculations
There are two ways methods to insert a calculation into a report:

**Right-click Menu**
1. Right-click in the column for desired calculation
2. Select **Insert**
3. Select the desired calculation

**Toolbar Option**
1. Select the column for desired calculation
2. Select **Analysis > Functions**
3. Select either **Sum**, **Count**, or **More** (Average, Min, Max, and Percentage)
Creating Additional Report Tabs

Web Intelligence allows you to create additional reports that can be used to display the data from your query in different ways.

You can create additional reports in two ways:

- Duplicate an existing report and then modify the new report.
- Add a new blank report, and then build the report by adding a template or dragging objects into the blank report.

**Duplicating a Report**

1. Right-click on the Report tab

2. Select **Duplicate Report** from the menu

![Duplicate Report Menu](image)

**Rename a Report**

1. Right-click on the Report Tab

2. Select **Rename Report**

3. Enter the new Report Name in the New Value box.

![Rename Report Dialog](image)

4. Click **OK**

**Note:**

When you rename the report tab, the report title is automatically updated.
Filtering a Report

Web Intelligence offers several ways to apply filters to a report. In this section we will cover how to use Report Filters, the Filter Toolbar, and Input Controls to filter the data displayed in reports.

Using Report Filters

1. There are two methods for accessing the Report Filter feature:
   a. Right-click in the column that you wish to filter, then select Filter > Add Filter
   
   ![Filter Toolbar](image1.png)

   b. Select the column that you wish to filter, then on the toolbars, select Analysis > Filters > Filter ▼ > Add Filter

   ![Analysis Toolbar](image2.png)

2. Select the operator to use for filter.

   ![Report Filter](image3.png)
3. Select the value(s) from the list of values. You must either double-click each value, or select the value and click the > button to move it to the list of Selected values.

![Filter Bar Example](image)

4. Click **Ok**

**Using Simple Filters on the Filter Bar**

Another way to filter a report is to add objects to the Filter Bar. This creates a more interactive filtering experience and can be used to drill-down within a report table.

**Displaying the Filter Bar**

There are two methods to displaying the Filter bar:

1. Right-click anywhere in the toolbar area

2. Click **Filter Bar**

![Filter Bar Display](image)
OR

1. Select the Properties tab

2. Select View > Filter Bar

Add Filters to the Filter Bar

1. Drag and Drop objects from the Available Objects list to the filter bar.

Or

2. Use the drop-down menu on the filter bar to add objects
3. Repeat to add a filter for any objects you would like to be able to filter on

4. To filter report, select value from drop-down filter boxes
Input Controls

Input Controls allow you to filter your data interactively using many types of controls, such as Radio Buttons, Drop-down lists, checkboxes, and slider bars.

1. There are two methods for creating a new Input Control:
   a. Right-click in the desired column to filter
   b. Select Filter > Filter by a New Input Control

OR

a. On the toolbars, select Analysis > Filters > Input Controls

2. Verify that the correct object is selecting and click Next
3. Select the desired control type from the menu to the left

4. Modify any properties needed, based on the control type selected.

5. Click **Next**

6. Select the report elements that should be controlled by the new input control.

7. Click **Finish**
The new Input Control will be displayed in the Input Control menu on the left sidebar.

8. Select value(s) to filter the report

**Editing or Removing an Input Control**

1. In the Input Control sidebar, hover mouse over the title of the control

2. Click to edit the control

3. Click to remove the control
Creating Variables

There are two methods for bringing up the Create Variable window:

1. From the **Available Objects** menu, right-click on the **Variables** folder and select **Create New Variable**

2. From the toolbars, select **Data Access > Data Objects > New Variable**

The Create Variable window is displayed.
3. Enter the name of the variable.

4. Select the Qualification for the variable. (Dimension, Detail, or Measure)

5. If selecting a Detail, select the Associated Dimension by clicking the button.

6. Enter the formula for the variable in the Formula box. Use the Available Objects, Functions, and Operators lists to assist in writing the variable formula.

7. Click the validate button to validate your formula.

8. Click OK to exit and save your variable.

**Displaying a List of Values in the Variable Editor**

If you are inserting values for a particular object into the variable formula, you can choose the values from the list of values:

1. Select the Object from the Available Objects list.

2. Double-click the Values option under Operators.

3. Select the value(s) to add to the formula and click OK
Grouping

Web Intelligence 4.1 allows you to create Grouping variables to group your data, for example, you can create groups based on the number of students enrolled in a course, or categorize transactions.

1. From the Toolbars, select **Analysis > Display > Group**

(Or right-click in the column to group, and select **Group > Manage Groups**)

2. Enter a name for the grouping variable (For example: “Enrollment Levels”)

3. Select values to include in the first grouping

4. Click the **Group** button

5. Enter a name for the new group and click **OK**
6. Repeat steps 3-5 until all groups have been created

7. To manage ungroup values, click the **Ungrouped Values** button. There are two options for ungrouped values:
   a. Check **Visible** to see the actual value
   b. Check ** Automatically Group** to assign a group name for all ungrouped values

8. Click **Ok** to exit Manage Groups window.

9. The Grouping will be displayed in the **Variable** folder in the **Available Objects** list.
To manage an existing group:
1. Right-click in the grouped variable column.
2. Select Group > Manage Group

To manage a particular value:
1. Right-click on the value
2. Select Group
3. Select from options:
   a. Move to Group
   b. Ungroup
   c. Rename Group
Inserting Predefined Cells into Report

Web Intelligence provides several predefined cells that can be added to enhance your reports. The following cells can be found in the Report Element toolbar tab:

**Available Predefined Cells**

- **Document Name**  
  Displays the Document Name

- **Last Refresh Date**  
  Displays the date the report was last refreshed

- **Drill Filters**  
  Displays all applying drill filters (using the Filter bar)

- **Query Summary**  
  Displays a summary of the query including the Universe name, object descriptions, and number of rows returned.

- **Prompt**  
  Displays a summary of all prompts, or individual prompts

- **Report Filter Summary**  
  Displays all report filters that are applied to a report

- **Page Numbers**  
  Displays the page number on the report. Can also include total number of pages.

**Adding a Prompt Summary**

1. Select the **Report Element** toolbar tab
2. Select the **Cell** sub-tab
3. Select the **Pre-Defined** Drop-down menu button
4. Select **Prompt > Prompt Summary**
5. Click your mouse in the location to display the prompt summary

*** Query Name: Query 1 ***

Select 6 digit Term Code
Select Course Subject Code
Enter value(s) for Course Number Level (Optional)

<table>
<thead>
<tr>
<th>Course Subject Code</th>
<th>Course Number</th>
<th>Section Number</th>
<th>Instructor Last Name</th>
<th>Section Building Name</th>
<th>Section Room Number</th>
<th>Section Enrollment</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMM</td>
<td>101</td>
<td>A</td>
<td>Sloane</td>
<td>Gregory Hall</td>
<td>113</td>
<td>24</td>
</tr>
<tr>
<td>COMM</td>
<td>101</td>
<td>B</td>
<td>Elavsky</td>
<td>Gregory Hall</td>
<td>113</td>
<td>26</td>
</tr>
</tbody>
</table>

6. Click on the **Format** toolbar tab to change the font and cell formatting for the Prompt Summary
Merge Dimension

Merge Dimension allows you to synchronize data from multiple data providers into one Web Intelligence report based on a common dimension object.

**Step 1: Sort Available Objects by Query**

1. Select the **Available Objects** list in the left sidebar.

2. At the bottom of the Available Objects panel, select **Arranged by:** drop-down menu

3. Select **Query**

The Available Objects list will now be sorted by Query:
Step 2: Merge Dimension Objects

Dimension Objects from different data sources can be merged in two ways:

Using the Right-click Menu

1. In the Available Objects menu, select the first object to merge.
2. Hold down the **CTRL** key, and select the second object to merge.

   **Note:** The object will most likely be grayed out, but you will still be able to select it.
3. Right-click on that object, and select **Merge**

The new Merged Dimension will be displayed in the **Merged Dimension** folder:
Using the Data Access Toolbar

1. Select the Data Access toolbar tab.

2. In the Data Objects tab, select Merge.

3. Select the first object to merge.

4. Hold down the CRTL key, and then select the second object to merge.

5. Click OK

The new Merged Dimension will be displayed in the Merged Dimension folder:
**Step 3: Create Variables for Objects to be Displayed with Other Data Source**

Business Objects has a rule that only objects from a single data source may be displayed together in a table (or block) of data. In order to join objects from multiple data sources into the same block of data, you must build Variables for each object, and those variables must be created as Details of the Merged Dimension.

1. In the Available Objects listing, right-click on the Variables folder

2. Select **Create New Variable**

   ![New Variable](image)

   **Note:** You may also select the Data Access toolbar tab, then select New Variable from the Data Objects menu.

3. Enter a name for the variable.

   **Note:** You must use a distinct name. It cannot be the same as any of the objects in your query.

4. From the Qualifications drop-down menu, select **Detail**

5. Select the button to the right of the Associated Dimension field.
6. Change the **Arranged by**: option to **Query**

7. Select the Merged Dimension object from the list of available objects.

8. Click **OK**

9. Double-click the desired object from the Available Objects list in the variable window. The formula =**[object name]** will be populated in the Formula box.
10. Click OK

The new detail variable has been created and added to the Variables folder.

11. Drag and Drop the variable into the desired location in the Data Block.
Report Formatting

**Viewing the Print Preview (Page View)**
To see what your document will look like when printed, change the view mode to Page Mode:

1. Select the **Page Setup** tab
2. Select the **Display** sub-tab.
3. Click the **Page** button.

![Page Setup Tab](image)

**Scaling (Fit to Page)**
If your report has many columns, you can use the Scale to Page feature to easily fit your report to one page width.

1. Select the **Page Setup** tab.
2. Select the **Scale to Page** sub-tab.
3. Use the Width or Height drop-down menus to select the desired scale.

![Scale to Page Tab](image)

**Changing Page Margins**
1. Select the **Page Setup** tab
2. Select the **Margins** tab
3. Use the **to adjust each of the four margin settings.**
Wrapping Text

1. Select the desired cell for Wrap Text.
   
   **Note:** To wrap text in multiple cells, hold down the CRTL key while selecting cells.

2. Select the **Format** tab, then the **Alignment** sub-tab.

3. Click the **Wrap text** button.

---

**Note:** You can also find report formatting options if you right click on any white-space on your report, then select **Format Report**. space on your report, then select **Format Report**.
Changing Row Height and Column Width

1. To adjust the column width, double-click on the right border of the column, or drag the border to the desired width.

2. To adjust row height, double-click on the bottom border, or drag the border to the desired row height.

Rearranging Columns

1. Click your mouse anywhere in the column that you would like to move.
2. Drag and drop the column to the desired location.
3. Use the blue rectangle to determine the new column location.

Deleting a Column

If you no longer want a column displayed in a table, you can delete it:

1. Select the column to be removed.
2. Click the Delete button (or right-click and select Delete)
Format Numbers

You can change how numeric values in certain cells or columns are displayed. By default, number formats are defined for the objects in the universe. Use Format Number to select another predefined format, or to create a custom format for numbers in your report.

1. Right-click in the column or cell that contains the number values to reformat.

2. Select Format Number

3. Select the type of number to be formatted (Number, Currency, Date/Time, etc.)
4. Select a predefined format, or click Custom to create a custom format.

![Custom Format Selection](image)

5. Click OK

**Editing the Report Title**

1. Double-click in the Report 1 cell.

![Report 1 Cell](image)

2. Enter a new name in the formula editor box

![Formula Editor Box](image)

3. Click the Validate checkmark

![Validated Formula](image)

**Note:**
If you rename the report tab, the report title will be updated to match.
Conditional Formatting

You can set up conditions that will automatically format the data in your Web Intelligence documents to alert you to when values fall below or above specific thresholds, or when certain strings appear.

1. Select the **Analysis** tab
2. Select the **Conditional** subtab
3. Click **New Rule** to create a new conditional formatting rule

4. Enter a name for the rule in the Name box
5. In the Filtered Object or Cell field, click the **...** button
6. Select the desired object for the conditional formatting rule
7. Click **Select an Object or a Variable**
8. Select the object or variable from the list of Available objects and click **OK**

9. Select an operator from the Operator drop-down list.
10. Type a value in the Operand field, or click the button to select a value from the list of values.

11. Click the Format button to change the way you want the values to be formatted if the condition is true. (Default will be to display value in red text)

12. Click OK

13. To add another conditional rule, click the button.

14. When all rules have been created, click OK
Applying the Formatting Rule to a Table:

1. Select the column that the rule will apply to

2. On the **Analysis > Conditional** menu, select **Formatting Rules** drop-down menu

3. Check the rule you would like to apply to the column.

![Formatting Rules](image)

Example: Format all sections with an enrollment less than 10

<table>
<thead>
<tr>
<th>Name</th>
<th>Section Room Number</th>
<th>Section Enrollment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Hall</td>
<td>336</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Hall</td>
<td>123</td>
<td>21</td>
</tr>
<tr>
<td>Hall</td>
<td>123</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>
Appendix A: Installing Web Intelligence Rich Client

Web Intelligence Rich Client can be installed on your computer desktop so that you can create and refresh Web Intelligence documents locally. The software is installed from the Preferences menu of EDDIE. You must be an administrator on your computer to install the software.

Log into EDDIE

1. Go to the EDDIE login Page: https://eddie.ds.uillinois.edu/
2. Enter your NetID User Name and Password.
3. Click Log On

Setting your Web Intelligence Preferences

1. Select Preferences (upper right corner)

2. Under Preferences – select Web Intelligence
3. Under Modify (creating, editing and analyzing documents), select **Desktop** (Rich Client, Windows only, installation required)

4. Click the **Save** button. (Bottom right corner of window)
Installing Web Intelligence Rich Client

**Note:**
These installation instructions are written for installing from Internet Explorer 9. SAP Business Intelligence 4.1 also supports Chrome and Firefox. Steps 2-3 below may vary based on the browser used for the installation.

1. Click on **installation required** link. (Link will look grayed out, but click it anyway)

2. When prompted to either run or save the WebSetup.exe file from EDDIE. Click **Run**

   Setup file will begin to download.

3. If asked if you want to allow the SAP AG Program to make changes to this computer, select **Yes**

4. For setup language, Click **OK**
5. If all prerequisites are met, click **Next**

6. Click **Next** to run the setup
7. Select “I accept the License Agreement” and then click Next.

8. Click Next to accept the default destination folder information.
9. Click **Next** to select the default language package

10. Click **Next** to select the default features
11. Click **Next** to start installation

12. Click **Finish** to exit the installation

13. When installation is complete, return to EDDIE preferences window. Click **Save & Close** to save your selected preferences.
Appendix B: Trouble-shooting Common Issues

Issue 1: Unable to Refresh Document. Refresh Button is grayed out

This issue is often happens when opening a document that has the Remove Document Security feature enabled. When the document was saved, the author checked the Remove Document Security box. If you open an unsecured Web Intelligence document when you are not logged into Web Intelligence and connected to the server, you will not be prompted to enter your Business Objects credentials, and therefore will be working in Offline or Disconnected mode.

Solution:

1. Check your Connection Status
   a. Look in the bottom right-hand corner of your window. You will see either Connected or Disconnected.
   b. If disconnected, you will need to connect to the server before being able to refresh your document.

2. Connecting to the Server
   a. Close the document.
   b. Launch the SAP Web Intelligence program.
   c. Click the Web Intelligence menu.
d. Select **Login as**

e. Enter your University NetID login credentials and click **Log On**

![SAP BusinessObjects Web Intelligence login dialog box]

f. Re-open the document.

### 3. Changing the Document Security Setting

If you reinstate the Document Security setting, you will be prompted to enter your Business Objects credentials when opening the document. To change this setting:

a. Open the document

b. On the **File** tab, Click the **Save** drop-down menu

c. Click **Save as**

d. Remove the check for **Remove Document Security**

e. Click **Save**
f. Pop-up asks if you want to overwrite the file, click **Yes**

![Save Document dialog box with 'Save for all users' and 'Remove document security' options highlighted.]

**Note:** If you are not the original creator of the document, unchecking the Remove Document Security box might cause issue with being able to refresh and edit the report. If this happens, recheck the Remove Document Security, and log completely into Web Intelligence before running the report.
**Issue 2: Document Opens in Reading Mode. Cannot Edit. Toolbars missing**

If you open a Web Intelligence document and it looks like the example below, you are in Reading Mode. Web Intelligence 4.1 has two view modes: Reading and Design. Reading mode is a read-only mode used to view data, but does not allow access to make changes.

**Solution:**

1. Click the **Design** button.

![Reading Mode](image1.png)

![Design Mode](image2.png)